Provider Portal User Guide

Version 4.5.2
# Table of Contents

Document Overview .................................................................................................................. 5  
   Purpose of this Document ................................................................................................. 5  
   Intended Audience .......................................................................................................... 5  
   What’s New in this User Guide? ...................................................................................... 5  
   Assistance ......................................................................................................................... 5  
Accessing the Provider Portal ................................................................................................. 6  
Creating a Provider Portal Account ....................................................................................... 6  
Troubleshooting a Provider Portal Account Error Message .................................................. 12  
Provider Portal Returning User ........................................................................................... 13  
   Log on Process .................................................................................................................. 13  
   Password Recovery .......................................................................................................... 13  
   Change Password Process ............................................................................................ 15  
Provider Dashboard ............................................................................................................ 17  
   Update Provider Portal User Account Information .......................................................... 17  
   Multiple Sites ................................................................................................................... 19  
   Manage Sites .................................................................................................................... 19  
   Manage Users .................................................................................................................. 22  
   Broadcast Messages ......................................................................................................... 27  
   Coalition Messages .......................................................................................................... 28  
   Frequently Used Links ...................................................................................................... 28  
Completing the Provider Profile ............................................................................................ 29  
   Request Assistance ........................................................................................................... 29  
   Business ........................................................................................................................... 31  
   Profile ............................................................................................................................... 33  
   Step 1 – General ............................................................................................................... 35  
   Step 2 – Facility ............................................................................................................... 36  
   Step 3 – Services .............................................................................................................. 38  
   Step 4 – Curriculum ......................................................................................................... 39  
   Step 5 – Fees & Discounts .............................................................................................. 39  
   Step 6 – Hours of Operation ............................................................................................ 40  


VPK-APP ........................................................................................................... 74
Step 1 – Attendance Policy .................................................................................. 74
Step 2 – VPK Director ......................................................................................... 75
Step 3 – VPK Instructors ..................................................................................... 76
Step 4 – VPK Calendars ....................................................................................... 77
Step 5 – VPK Class(es) ....................................................................................... 81
Step 6 – Review .................................................................................................. 82
Step 7 – Certify and Submit ................................................................................ 83
Updating a VPK-APP ........................................................................................... 84
VPK Director ....................................................................................................... 84
VPK Instructors .................................................................................................. 85
VPK Calendars .................................................................................................... 89
VPK Class(es) ..................................................................................................... 93
Editing an SR Contract Amendment ................................................................... 96
Viewing a Certified SR Contract Amendment ..................................................... 102
Editing the VPK Contract Amendment ................................................................ 103
Viewing a Certified VPK Contract Amendment ................................................... 107
Enrollments - VPK ............................................................................................. 108
Request/Change Enrollment ............................................................................... 108
Enrolling a VPK Child ....................................................................................... 109
Managing VPK Enrollment ................................................................................ 112
VPK Bulk Enrollment Process ............................................................................. 120
Enrollments - SR ............................................................................................... 125
Temporary Closures ............................................................................................. 126
Creating a Temporary Closure ........................................................................... 126
Updating VPK Class Calendar .......................................................................... 131
Instructional Day Exception ............................................................................... 134
Non-Instructional Day ....................................................................................... 137
Attendance - VPK ............................................................................................... 140
Submitting Attendance Online ........................................................................... 140
Submitted Attendance ....................................................................................... 142
Rejected Attendance ......................................................................................... 143
Table: Document Revision History

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Date</th>
<th>Author</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0</td>
<td>04/25/19</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>4.1.6</td>
<td>11/20/19</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>4.2</td>
<td>01/28/20</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>4.3</td>
<td>05/04/20</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>4.5</td>
<td>09/27/20</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
<tr>
<td>4.5.2</td>
<td>10/29/20</td>
<td>Jim Ledbetter</td>
<td>Final</td>
</tr>
</tbody>
</table>

Document Overview

This document provides a step-by-step guide to navigate the Provider Portal.

Purpose of this Document

The purpose of this document is to provide Provider Portal users with a reference document to successfully navigate and perform business processes included in Release 4.5.2 of the Provider Portal.

Intended Audience

The intended audience for this document includes provider staff responsible for completing profiles, contracts, enrollments, and attendance.

What’s New in this User Guide?

New screenshots and text for Temporary Closures.

Assistance

If you have questions about any of the material in this user guide or about any processes not covered by this guide, please contact the Office of Early Learning Service Desk at Service.Desk@oel.myflorida.com or (850) 717-8600.
Accessing the Provider Portal
The link to access the Provider Portal is https://providerservices.floridaearlylearning.com.

Creating a Provider Portal Account
First-time Provider Portal users must register for an account to access the Provider Portal. Provider Portal users with multiple provider sites should begin by registering only one site location. This could be the provider’s primary, flagship or main location. Once a Provider Portal account registration request is approved for one provider site, the provider user will be able to create accounts for additional sites after logging on to the Provider Portal.

Click the here link to start the new account registration process and the following page will display:

A Provider Portal user must enter the taxpayer identification number (from the provider), the provider identification number (from the early learning coalition) and the Department of Children and Families (DCF) license, registration, exemption number or type the word “EXEMPT”. Providers may enter “EXEMPT” if they do not have an exemption number from DCF.

The Provider Portal user must click the Verify License Details button to complete step 1 of the Provider Portal account registration process.
If a match is found for the submitted information, the following message will display:

### Provider Data Found

We found the following Provider data which corresponds to the license information that you entered. If we've correctly identified your provider, click Yes to pre-fill sections of the registration form. Otherwise, click No and try again with different license information.

- **Business name:** 4 Kids Academy
- **Doing Business As name:** 4 KIDS ACADEMY
- **Owner name:** SARINA

Is this your provider?  
Yes ✅  No ✗

If the information is not correct, click the **No** button and contact the local early learning coalition.

If the information is correct, click the **Yes** button. On the next screen, the registration information will be populated by the system, with the exception of User Information.

If a match is not found for the provider information, the following message will display:

### No Matching Provider Data Found

- **Taxpayer or Provider ID:** ✗ 0000000000
- **License/Registration/Exemption #:** ✗ EXEMPT

We were not able to find matching provider site or principal business data to the specified taxpayer/license information. If you are a new provider, this situation is to be expected.

If you have reason to expect that your information should be in our provider system, please re-enter your license information and try again or contact your [early learning coalition](#) for assistance.
After filling in the required information (noted with a red asterisk *), the Provider Portal user must click the **Register** button to complete the registration process.

**License Details**

**Taxpayer or Provider identification number**

34534534545

**License/Registration/Exemption number, or EXEMPT**

EXEMPT

**Business Details**

**Business name associated with your taxpayer identification number**

**Owner/Operator name**

**Principal Address line 1**

**Principal Address line 2**

**Principal City**

**Principal State**

**Principal Zip code**
Location Details

☐ Redlands Christian Migrant Association (RCMA) Provider

Doing Business As name (DBA)*

Provider type*

Not Selected

Legal status*

Contact person phone number*

Physical Address of Facility

☐ Facility address is the same as principal address.

Address line 1*

Address line 2

City*

State

Florida

Zip code*

County of physical location*

--please select a value--
User Information

First name

Middle name

Last name

Account user name (must be a valid email address)

Confirm account user name

Password (must contain at least 8 characters)

Confirm password

Register
After clicking the **Register** button, the following message may display:

![Address Verification](image1)

**Principal Address of Business**

<table>
<thead>
<tr>
<th>Entered Address</th>
<th>USPS Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Example St, TALLAHASSEE, FL - 32399-0001</td>
<td>100 EXAMPLE ST, TALLAHASSEE, FL 32399-0001</td>
</tr>
</tbody>
</table>

Click the **Select this** radio button to accept the standardized United States Postal Service (USPS) address or the Entered Address if the USPS Address is not found. Then, click the **Apply** button to continue. If the Provider Portal user clicks the **Close** button, the user will be taken back to the previous screen to re-enter the address information.

Once the Provider Portal user submits an account request, the following page will display:

![Account Request Confirmation](image2)

The Provider Portal user should access the email address used in the account and find the email sent by DONOTREPLY@oel.myflorida.com.

If the registration request is approved, the following email will be sent by DONOTREPLY@oel.myflorida.com.

Hello Jim Ledbetter,

You are receiving this email because someone registered this email address for an account in Florida’s statewide early learning Provider Portal. You will receive an email that will notify you how to proceed after your request is processed by your local early learning coalition.

ELC of the Big Bend Region
(850) 573-5010
http://www.elcbigbend.org/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early Learning Coalition at the number listed above.

Hello Jim Ledbetter,

The Provider Portal registration request you submitted for Jim's House of Learning 2 has been approved. You may now log on to the Provider Portal with the username and password you registered with.

ELC of the Big Bend Region
(850) 573-5010
http://www.elcbigbend.org/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early Learning Coalition at the number listed above.
The Provider Portal user can log on to the Provider Portal at https://providerservices.floridaearlylearning.com.

Troubleshooting a Provider Portal Account Error Message

If the Provider Portal user receives the following message, contact the local early learning coalition to verify that the taxpayer identification number matches the OEL database.

The license number belongs to a provider/business that is associated with a different taxpayer identification number.

If the Provider Portal user receives either of the following messages, contact the local early learning coalition to determine if a provider portal account has already been created.

The license number belongs to a provider that is already associated with a registered account.

The taxpayer or provider identification number belongs to a business that is already associated with a registered account.

If the Provider Portal user receives the following message, contact the local early learning coalition to determine if the user name (email address) has been used in the Family Portal. The coalition may need to consult with OEL to make this determination. If a user name has been used in the Family Portal, even if an application was not created, OEL will have to remove the user name from the database so it can be used in the Provider Portal. If a provider has improperly used a user name to complete SR or VPK applications for a parent, the provider must contact that parent to get a replacement user name for that application so the provider’s user name can be used in the Provider Portal. Another option is for the provider to pick another user name to use in the Provider Portal.

Account user name (must be a valid email address) *

| oeldemonstration+pb@gmail.com |

User name "oeldemonstration+pb@gmail.com" is not available.
Provider Portal Returning User

Log on Process
Provider Portal users who have already created a user account can log on from the Provider Services welcome page by entering the user name and password created during the account process. Click the Log On button to continue.

Password Recovery
If the Provider Portal user cannot remember the password, the user can click the Forgot my password link.

Clicking the Forgot my password link will display the following page:
The Provider Portal user must know the email address used for the account. Once the Provider Portal user enters an email address and clicks the **Continue** button, the following page will display:

**Forgot Password Confirmation**

A password reset link was sent to the email address associated with your account. Please click Continue to proceed to the login page.

[Continue]

The Provider Portal user should then access the email account used for the account and find the email sent by DONOTREPLY@oel.myflorida.com.

[Image]

You are receiving this message because you or someone else from this email address requested a new Provider Portal password. Please disregard this email if you did not request a new password.

To reset your password you must complete the following steps:

1. Please reset your password by clicking [here](#).
2. Enter your user name — It must be the email address you registered for a provider account with.
3. Enter in your new password.
4. Confirm your new password.
5. Click the Reset Password button. A Reset Password Confirmation screen will display if the login was successful.
6. Click the Continue button. The Provider Services Login page displays and you are now ready to sign in with the new password.

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early Learning Coalition at the number listed above.

Once the Provider Portal user clicks the **here** link, the following page will display:

**Reset Your Password**

**Account Information**

Please type the user name and new password for your account, and then click **Reset Password**.

**User name**

Enter User Name

**Password (must contain at least 8 characters)**

Enter Password

**Confirm password**

Enter Password

[Reset Password]

The Provider Portal user must enter the user name (email address), new password and confirm the new password. After entering the required fields, click the **Reset Password** button to continue.
If the Provider Portal user successfully changes the password, the following page will display:

Change Password Process

A Provider Portal user can change the password at any point by clicking the Change my password link.

Clicking the Change my password link will display the following page:

The Provider Portal user must enter the User Name (email address), current password, new password and confirm the new password. After entering the required fields, click the Change Password button to continue.
If the Provider Portal user successfully changes the password, the following page will display:

Password Change Completed

The password for your account was successfully changed.
Please click **Continue** to proceed to the login page.
**Update Provider Portal User Account Information**

Provider Portal users are able to update their user information – name and phone number – associated with their email address. If the name associated with an email address is blank, the user can add the first and last name. If a name associated with a standardized email address (e.g. Info@JimsHouseofSmarties.com) needs to be changed due to a director or other staff leaving, the first and last name can be changed as long as another user has access to that Provider Portal account. If no one has access to the Provider Portal account, contact your local early learning coalition to submit a ticket to the OEL Service Desk.

Click on the gear icon.

The following will display. Click the **Account Information** button.
Enter the additional information and click **Save**.

<table>
<thead>
<tr>
<th><strong>Update User Account Information</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Please update your account details to continue</td>
</tr>
</tbody>
</table>

- **First Name**: Jim
- **Middle Name**: Enter Middle Name
- **Last Name**: Ledbetter
- **Suffix**: 
- **Phone Number**: (850) 717-5607

[Save] [Cancel]
Multiple Sites

If the Provider Portal user registered a provider site that shares a taxpayer identification number with multiple sites, all of the sites with a shared taxpayer identification number will appear in a dropdown list for that Business Administrator.

Manage Sites

Providers with multiple site locations can use this feature to manage additional sites. Click the Manage All Sites link to add new provider sites. Additional sites can only be added if the sites share the same taxpayer identification number. This function will only be needed if the provider site is not found in the OEL database. Sites that share the same taxpayer identification number will automatically be assigned to the Business Administrator who registered the first provider site with the same taxpayer identification number.
After clicking the **Add Site** button, the following message will display:

Add New Site

To add a new site for your business, first type the license, registration, or exemption number of the new site, and then click Verify License to verify that the license number is available for use with the system.

License/Registration/Exemption number, or EXEMPT

[Verify License]

Save  Cancel

If the new provider site matches, the location information will be pre-populated.
If the new provider site does not match, the location information must be entered by the Provider Portal user.
After clicking the **Register** button, the following message may display:

**Address Verification**

USPS standardized address is **250 MARRIOTT DR TALLAHASSEE FL 32399-6573**

Would you like to use this address instead of entered address?

Click the **Yes** button to accept the standardized United States Postal Service address. Click the **No** button to go back to the previous screen to re-enter the address information.

**Manage Users**

Click the **Manage All Users** link to edit, add, and inactivate provider site users.
To edit the role of a Provider Portal user, click the **Edit** button.

**Provider User Roles:**

- **Business Administrator** – Able to edit the provider profile and principal business information that is shared among associated provider sites; able to add provider sites and users; submit profiles and profile updates; and create contracts. This role would typically be assigned to an owner.
- **Site Administrator** – Able to edit the provider profile associated to their site and add provider users for a site, but cannot create a new site. This role would typically be assigned to a principal or director.
- **User** – Able to perform administrative tasks based on permissions granted by the Business Administrator or Site Administrator. This role would typically be assigned to teachers and aides.

After changing the role, click the **Save** button to continue.

To add a user, click the **Add User** button.
In the user name field, the Provider Portal user will enter the email address of the new user. If the user already has an account in the Provider Portal, the user role must be selected. Click the **Save** button to continue.
In the user name field, the Provider Portal user will enter the email address of the new user. If the user does not exist in the system, the user’s information and role must be entered. Click the **Save** button to continue.

Once the new user has been added, an email will be sent to the new user by **DONOTREPLY@oel.myflorida.com**.
The User role has a set of permissions that can be individualized for each User. Each option is unchecked by default and must be checked to add to the User. Click the **Save** button to continue.

---

**Edit User Permissions**

Make the desired changes to the user's role and permissions, and then click **Save**.

**Role**

- User

**Permissions**

- Attach Profile Documents
- Create Banking Information
- Create Calendar
- Create Profile
- Create SR Contract
- Create VPK Contract
- Edit Banking Information
- Edit Calendar
- Edit Profile
- Edit Site
- Edit SR Contract
- Edit VPK Contract
- Manage ASQ
- Manage Document Library
- Manage Messages and Notifications
- Manage Other
- Modify and Submit SR Attendance Rosters
- Modify and Submit VPK Attendance Rosters
- Reports
- Review Attendance Rosters

---

[Save]  [Cancel]
To inactive a user, which will remove the user from the site, click the **Inactivate** button.

If the Provider Portal user discovers that an email address has an error after it has been entered, the user can add the correct email address by clicking the **Add User** button, entering the required information, and then click the **Save** button. Then, the user will click the **Inactive** button for the email address which has the incorrect email address. For example, from the above Manage All Users screen, if the Business Administrator’s email address was incorrectly entered as oeldemonstation@gamaial.com, the process would be to click the **Add User** button and create oeldemonstation+3@gmail.com, click **Save**, and then click **Inactivate** for oeldemonstation@gamaial.com. It is important to create the correct email address first before inactivating the incorrect email address.

**Broadcast Messages**

The Broadcast Messages section of the Provider Dashboard will display all messages sent by the local early learning coalition to all providers in the coalition service area. Click the message title to see the full text of the message.
Coalition Messages

The Coalition Messages section of the Provider Dashboard displays messages sent by the local early learning coalition to a specific provider. This is a one-way communication; the provider cannot email the coalition directly from the portal. Click the message title to see the full text of the message.

Frequently Used Links

The Frequently Used Links section of the Provider Dashboard has links to web pages with information about statewide provider requirements, training and services.
Completing the Provider Profile

After registering as a provider, the next step is to complete the Provider Profile.

Request Assistance

If a Provider Portal user needs assistance filling out any information in the Provider Profile, click the **Request Assistance** button.

Then, complete the field, briefly describing the need for assistance. Click the **Submit** button to send the request.

After clicking **Submit**, the following message will display:
The Provider Portal user will not be able to edit the profile once the request for assistance is submitted; however, coalition staff will be able to edit information in a profile while providing assistance to a Provider Portal user.

The request for assistance can be cancelled by the Provider Portal user by clicking the Cancel Assistance Request button.

If a Provider Portal user cancels the assistance request, the following message will display and the user will complete the field, briefly describing the reason for cancelling the request. Click the Submit button to continue.

After cancelling the request, the following message will display:
Business

The Business Information page collects business information about the provider, including business name and address information, and it is shared among additional sites (if any). Only a Business Administrator may edit the information on this page.

**NOTE:** This information was previously captured in the Business tab of the provider profile. Although the Business Information page is now separated from the provider profile, it must be completed before the profile may be submitted.

Tool tips, indicated by the symbol, are available to provide useful information to Provider Portal users about specific terms in the Provider Profile. Click the to see the message.

To complete the Business Info page, click the **Business** dropdown menu from the Provider Dashboard.

Then, click **Business Info**.
Business Information

1. Business Name Associated with Your Taxpayer Identification Number
   Jim's House of Learning 3

2. Taxpayer Identification Number
   888888888

3. Owner Information
   Owner Name
   Jim Lodbett
   Owner Email Address
   fake@flio.com
   Owner Telephone Number
   (665) 566-6665
   Owner Phone Type
   Mobile Phone
   Owner Phone Number
   Unknown

4. Owner's Designee or Contact Person Information
   Designee/Contact Name
   Jim Lodbett
   Designee/Contact Email Address
   fake@flio.com
   Designee/Contact Telephone Number
   (555) 555-5555
   Designee/Contact Phone Type
   Unknown

5. Business Ownership Type
   Corporation

6. Physical Address Information
   Address Line 1
   250 MARRIOTT DR
   Address Line 2
   City
   TALLAHASSEE
   State
   FL
   Zip Code
   32301

7. Mailing Address Information
   Mailing address is the same as the principal address.
   Address Line 1
   250 MARRIOTT DR
   Address Line 2
   City
   TALLAHASSEE
   State
   FL
   Zip Code
   32301

8. Payment Mailing Address Information
   Payment address is the same as the mailing address.
   Address Line 1
   250 MARRIOTT DR
   Address Line 2
   City
   TALLAHASSEE
   State
   FL
   Zip Code
   32301

Save
Profile

A Provider Portal user must fill out all information in each tab, and click the **Next** button to continue filling out the provider profile information. Click the **Back** button to return to the previous tab.

Tool tips, indicated by the 📄 symbol, are available to provide useful information to Provider Portal users about specific terms in the Provider Profile. Click the 📄 to see the message.

To complete the Provider Profile, click the **Profile** dropdown menu from the Provider Dashboard.

Then, click **Provider Profile**.
Yellow Warning Symbols

Yellow warning symbols will appear on certain fields on the following tabs: General, Facility, Services, Curriculum, Staffing & Capacity, and Documents.

If the Provider Portal user hovers over the yellow warning symbol, the following message will display.

Warning!

This information is included in the VPK Provider Application (VPK 10, 11A, 11B). Editing this information after an application is created will result in an update to the forms. The Early Learning Coalition will notify you to review the updated forms and re-submit as needed.

If a change is made, the coalition will review the change and change the profile status to **Incomplete** to allow the Provider Portal user to re-submit the VPK-APP. The user will receive the following email from **DONOTREPLY@OEL.myflorida.com**.

---

From: OEL System Test@oel.myflorida.com
Date: Wed, Aug 14, 2017 at 12:08 PM
Subject: Signature Required - VPK Provider Application Updated
To: stiahum77@gmail.com
Cc: MB@aceliance.com

Hello,

The VPK Provider Application (VPK 10, 11A, 11B) forms have been updated for Maggie Mae Daycare. Your review and signature is required. Please log on the Provider Portal and go to the Contracts menu, and choose Manage Contracts. On this page, locate your VPK-APP and click Edit. Review the VPK Provider Application information and submit your signature on the Certify and Submit tab.

Please review and submit your signature as quickly as possible.

Thank you,

ELC of the Big Bend Region
(850) 973-4010
http://www.elcbigbend.org/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have questions, please contact your early learning coalition.
Step 1 – General
The General tab collects basic information about the provider, including provider types and whether or not there is interest in contracting with the early learning coalition to provide School Readiness or Voluntary Prekindergarten (VPK) Education services.

General

1. Do you want to have your program referred to families seeking child care listings?
   - Yes
   - No

2. Do you want to complete a contract to participate in the School Readiness Program?
   - Yes
   - No

   2.1 Have you completed the Health & Safety Inspection by Department of Children and Families?
   - Yes
   - No

3. Do you want to complete a contract to participate in the Voluntary Prekindergarten (VPK) Education Program?
   - Yes
   - No

4. Do you want to complete a contract to receive local funding?
   - Yes
   - No

5. Are you a Gold Seal provider?
   - Yes
   - No

   5.1 Gold Seal Accreditation (select one)

   Gold Seal for Birth to 5

6. Are you an accredited provider?
   - Yes
   - No

   6.1 Accreditation (select all that apply)

   OTHER
Step 2 – Facility

The Facility tab collects contact information for the provider. The Provider Portal user is required to enter contact information for staff responsible for different aspects of the business. If the staff person is an Authorized Contract Representative or VPK Authorized Contract Representative, click the checkbox below each section (Director, VPK Director, etc.).

<table>
<thead>
<tr>
<th>Facility</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1. Doing Business as Name (DBA)</strong></td>
<td>Jen's House of Cares &amp; Gates</td>
</tr>
<tr>
<td><strong>2. Contact</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Telephone Number</strong></td>
<td>(954) 999-9999</td>
</tr>
<tr>
<td><strong>Fax Number</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td><a href="mailto:oreldemonstration-60@gmail.com">oreldemonstration-60@gmail.com</a></td>
</tr>
<tr>
<td><strong>Phone Type</strong></td>
<td>Mobile Phone</td>
</tr>
<tr>
<td><strong>3. Physical Address of Facility</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Address Line 1</strong></td>
<td>2000 HIGH RIDGE RD</td>
</tr>
<tr>
<td><strong>City</strong></td>
<td>BOYNTON BEACH</td>
</tr>
<tr>
<td><strong>County</strong></td>
<td>Palm Beach</td>
</tr>
<tr>
<td><strong>Address Line 2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>Florida</td>
</tr>
<tr>
<td><strong>Zip Code</strong></td>
<td>33426</td>
</tr>
<tr>
<td><strong>4. Director</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Director Name</strong></td>
<td>Not Jim Ledbetter</td>
</tr>
<tr>
<td><strong>Director Telephone Number</strong></td>
<td>(561) 555-5555</td>
</tr>
<tr>
<td><strong>Director Email</strong></td>
<td><a href="mailto:oreldemonstration-60@gmail.com">oreldemonstration-60@gmail.com</a></td>
</tr>
<tr>
<td><strong>Director Phone Type</strong></td>
<td>Mobile Phone</td>
</tr>
<tr>
<td><strong>5. VPK Director</strong></td>
<td></td>
</tr>
<tr>
<td><strong>VPK Director Name</strong></td>
<td>Not Jim Ledbetter</td>
</tr>
<tr>
<td><strong>VPK Director Telephone Number</strong></td>
<td>(561) 555-5555</td>
</tr>
<tr>
<td><strong>VPK Director Email</strong></td>
<td><a href="mailto:oreldemonstration-60@gmail.com">oreldemonstration-60@gmail.com</a></td>
</tr>
<tr>
<td><strong>VPK Director Phone Type</strong></td>
<td>Mobile Phone</td>
</tr>
<tr>
<td><strong>6. Legal Status</strong></td>
<td>Exempt</td>
</tr>
<tr>
<td><strong>7. Exemption Details</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Exempt Number</strong></td>
<td>EXEMPT</td>
</tr>
<tr>
<td><strong>Exemption Reason</strong></td>
<td>Private School</td>
</tr>
<tr>
<td><strong>Expiration Date</strong></td>
<td>03/20/2017</td>
</tr>
<tr>
<td><strong>Private School Code</strong></td>
<td>124</td>
</tr>
<tr>
<td><strong>8. Provider Type</strong></td>
<td>Private School</td>
</tr>
</tbody>
</table>

**Additional Facility Contacts**

[Add New Contact]
When the **Add New Contact** button is clicked, the Provider Portal user can create additional provider contacts for the profile.
Step 3 – Services

The Services tab collects information on the ages of the children in provider care, as well as different provider services.

<table>
<thead>
<tr>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Age of Children for which Care is Provided</td>
</tr>
<tr>
<td>Minimum Age</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2. Programs Offered (select all that apply):</td>
</tr>
<tr>
<td>Before School</td>
</tr>
<tr>
<td>3. About My Program (select all that apply):</td>
</tr>
<tr>
<td>Music Lessons</td>
</tr>
<tr>
<td>4. Languages Spoken by Staff (select all that apply):</td>
</tr>
<tr>
<td>English</td>
</tr>
<tr>
<td>5. Other Spoken Languages</td>
</tr>
<tr>
<td>6. Meals (select all that apply):</td>
</tr>
<tr>
<td>Morning Snack</td>
</tr>
<tr>
<td>8. Do you provide transportation services?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>8.1 Transportation (select all that apply):</td>
</tr>
<tr>
<td>Transportation to/from Local School</td>
</tr>
<tr>
<td>9. Do you currently implement a character development program?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>9.1 Description of Character Development Program (250 characters max)</td>
</tr>
<tr>
<td>blank</td>
</tr>
<tr>
<td>10. Is your program equipped to care for children with special needs?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>11. Is your facility wheelchair-accessible?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>12. Does your program/facility offer therapeutic services to children?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>13. Do you participate in a quality rating system?</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>14. Affiliation - Not for Profit</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
<tr>
<td>15. Military Child Care</td>
</tr>
<tr>
<td>☑ Yes</td>
</tr>
</tbody>
</table>
Step 4 – Curriculum

The Curriculum tab collects information about the provider’s curriculum. A provider may choose multiple curricula from the list. If the provider is a school readiness provider, an approved curriculum must be chosen. If no approved curricula are being used by the provider, the Provider Portal user should select “Other.” If a provider does not see their curriculum listed, choose “Other” as the curriculum.

Step 5 – Fees & Discounts

The Fees & Discounts tab collects information about fees the provider assesses the parent. The Provider Portal user should enter all applicable fees. All amount fields must have either a dollar amount or zero entered. If a fee is not applicable, the amount entered must be “0.” If there are no family discounts offered, the selection must be “None.”
Step 6 – Hours of Operation

The Hours of Operation tab collects information on the type of schedules offered for care. The Provider Portal user must click the checkbox next to the desired day of the week before inputting hours of operation for that day. The default hours of operation for each day are 6:00 a.m.– 6:00 p.m. An Enhanced Schedule is available.
Step 7 – Staffing & Capacity

The Staffing & Capacity tab collects information on how many children the facility will or can care for. These questions are asked by age group. For each care level, the Provider Portal user should enter the highest number of teachers and children for all classrooms for each care level. This tab does not calculate staff-to-child ratios, but stores staffing and capacity numbers for local early learning coalition review.

**Staff-to-child Ratio** is the number of children that an individual teacher is responsible for. To reflect the actual ratio, the “Teachers in Classroom” column should always be 1. For example, if you have 2 teachers with one class of 20, you should list 1 “Teacher in Classroom” with 10 “Children in Classroom” and a “Group Size” of 20. If you follow the state mandated ratios for a center or facility, please see the example below. You can omit the age groups you do not serve.

**Group Size** is the maximum number of children, by age, that can be in a single classroom at any given time. If you follow the state mandated group sizes for a center or facility, please see the example below. You can omit the age groups you do not serve.

### Staffing and Capacity

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Training/Education Type</td>
<td>Number of Staff</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-----------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FCCH 30 HOUR TRAINING</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40/45 HR INTRO CHILD CARE</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AAAS NONCHLD RELATED</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AAAS EARLY CHILDHOOD OR RELATED FIELD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL ADV</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL LEVEL 1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR CREDENTIAL LEVEL 2</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAE EARLY CHILDHOOD OR RELATED FIELD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BEHAVIOR OBSERVATION</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIRECTOR (NON VPK)</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GED/HIGH SCHOOL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EARLY (EMERGENT) LITERACY</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FOOD/ECDS/CC/CAC/IDAE</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MA DEGREE EARLY CHILDHOOD</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MA NONCHLD RELATED</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NATL EARLY CHILDHOOD CERT</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCHOOL-AJC CREDENTIAL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VPK DIRECTOR CREDENTIAL</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OTHER-LIST</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Example: Child Care Center 1
This example uses the state mandated minimum staff-to-child ratios and maximum group sizes permitted for centers.

Example: Child Care Center 2
This example uses more stringent staff-to-child ratios and group sizes that are smaller than the state mandate for centers.

For more information on staff-to-child ratios and group sizes for facilities, please visit the School Readiness Health and Safety Standards Handbook.
Example: Family Child Care Homes 1
A family day care home is allowed to provide care for one of the following groups of children, which includes household children under 13 years of age. Below are examples of how to fill out this table using the state mandated minimum ratios.

**The group size column should never exceed 10 for a family child care home.

This example uses the maximum of four children from birth to 12 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>12 - 24 Months</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24 - 36 Months</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36 - 48 Months</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>48 - 60 Months</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60 - 72 Months</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In School</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VPK Class</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example: Family Child Care Homes 2
This example uses the maximum of three children from birth to 12 months of age, and other children, for a maximum total of six children.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>12 - 24 Months</td>
<td>1</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>24 - 36 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>36 - 48 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48 - 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 - 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Example: Family Child Care Homes 3
This example uses the maximum of six preschool children if all are older than 12 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Example: Family Child Care Homes 4
This example uses the maximum of 10 children if no more than 5 are preschool age and, of those 5, no more than 2 are under 12 months of age.

<table>
<thead>
<tr>
<th>Care Level</th>
<th>Teachers in Classroom</th>
<th>Children in Classroom</th>
<th>Group Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 12 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>12 &lt; 24 Months</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>24 &lt; 36 Months</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>36 &lt; 48 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>48 &lt; 60 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60 &lt; 72 Months</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>In School</td>
<td>1</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Special Needs</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>VPK Class</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Example: Large Family Child Care Homes 1
A large family child care home is allowed to provide care for one of the following groups of children, which includes household children under 13 years of age.

**The group size column should never exceed 12 for a large family child care home.

This example uses the maximum of 8 children from birth to 24 months of age.

![Staffing and Capacity Table](image)

Example: Large Family Child Care Homes 2
This example uses the maximum of 12 children, with no more than 4 children under 24 months of age.

![Staffing and Capacity Table](image)

For more information on staff-to-child ratios and group sizes for family child care homes please visit the School Readiness Health and Safety Standards Handbook.
Step 8 – Private Pay Rates

The Private Pay Rates tab collects information on the provider’s private pay rate based on unit of care and care level. The Provider Portal user must enter in the private pay rates for each “Unit of Care” and “Care Level” offered by the provider. Shaded cells do not permit entry. If care is not provided for that Unit of Care and Care Level, no entry is needed.

Providers that indicate they want to complete a contract to participate in the school readiness program on the General tab will also have a section on the Private Pay Rates tab to enter the Daily Rates for the School Readiness Program. The Provider Portal user may edit the $0.00 amount for each “Unit of Care” and “Care Level” offered by the provider or click on the **SR Daily Rate Helper** button. The Helper button will automatically calculate the rates based on the Full Time Monthly Rates or Full Time Weekly Rates, and the Part Time Weekly Rates entered in the Private Pay Rates section. The rates are also editable after calculation. These rates will be utilized in the contracting process if the provider enters into a School Readiness contract with an early learning coalition.

**NOTE:** With Release 3.5, School Readiness providers must now answer a question regarding the family’s responsibility to pay the differential between the Approved Reimbursement Rate and the Private Pay Rate.
Step 9 – Closures Calendar

The Closures Calendar tab collects information on any days the provider will be closed. The Provider Portal user will select all closure days for the provider. Once selected, the date will change from white to blue. The local early learning coalition may define reimbursable holidays for the School Readiness program, which will be shaded gray. When a provider closure date and a coalition-defined reimbursable holiday are the same, the date will be shaded dark blue. A Provider Portal user does not need to include Saturdays and Sundays on the Closures Calendar if services are not provided on those days.

NOTE: Actual reimbursable holidays will be selected during the contracting process if the provider enters into a School Readiness contract with an early learning coalition.
Step 10 – Documents
The Documents tab allows the Provider Portal user to upload documents for the local early learning coalition to review. Based on provider answers in the provider profile, the Documents tab will display types of documents that may be uploaded to support a contract to provide School Readiness or VPK services. Users may enter up to five documents for each document type. Documents uploaded in this tab will also populate in the Document Library and will be utilized during the contracting process.

<table>
<thead>
<tr>
<th>Supporting Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate of Accreditation</td>
</tr>
<tr>
<td>Certificate of Licensure</td>
</tr>
<tr>
<td>Private Child Care Pay Rates</td>
</tr>
<tr>
<td>IRS Form W-9</td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
<tr>
<td>Upload Document...</td>
</tr>
</tbody>
</table>
Step 11 – Review

After reviewing the information for each section, the Provider Portal user must click the Next button to continue.

Click the + to expand and the - to collapse each section below. Click the button to navigate back to that section.

<table>
<thead>
<tr>
<th>Section</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do you have a program offering services to children with special needs?</td>
<td>Yes</td>
</tr>
<tr>
<td>2. Do you want to complete a contact to participate in the School Readiness Program?</td>
<td>Yes</td>
</tr>
<tr>
<td>2.1 Have you completed the health &amp; safety inspections by the Department of Children and Families?</td>
<td>Yes</td>
</tr>
<tr>
<td>3. Do you want to complete a contact to participate in the Early Childhood Education Program?</td>
<td>Yes</td>
</tr>
<tr>
<td>4. Do you want to complete a contact to receive supplementation?</td>
<td>Yes</td>
</tr>
<tr>
<td>5. Are you a Head Start provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>5.1 Gold Seal Accreditation</td>
<td>Gold Seal for Pre-K &amp; 5</td>
</tr>
<tr>
<td>6. Are you an accredited provider?</td>
<td>Yes</td>
</tr>
<tr>
<td>6.1 Accreditations</td>
<td>OTHERS</td>
</tr>
</tbody>
</table>

Closures Dates

<table>
<thead>
<tr>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/4/2017</td>
</tr>
<tr>
<td>5/5/2017</td>
</tr>
<tr>
<td>6/4/2017</td>
</tr>
<tr>
<td>5/5/2017</td>
</tr>
<tr>
<td>8/10/2017</td>
</tr>
<tr>
<td>11/11/2017</td>
</tr>
<tr>
<td>5/12/2017</td>
</tr>
</tbody>
</table>
Step 12 – Sign and Certify

To submit the Provider Profile, the Full Name must exactly match (and is case-sensitive) the name entered on the Manage Users page. The Provider Portal user must then check the “Check box to certify by electronic signature” check box and click the **Submit** button.

Once the Provider Portal user submits the Provider Profile, the following page will display:

**You Have Successfully Completed and Submitted your Provider Profile**

Your early learning coalition will process your profile.

Please check your email for important information about your profile.

You can click on the button below to return to the home page.

Return to home page

The Provider Portal user should then find the email sent by DONOTREPLY@oel.myflorida.com.
Managing a Profile as a Provider Portal User

Provider Dashboard

On January 1 of each program year, a button will appear next to the current program year that will allow the Provider Portal user to migrate all profile information from the current program year to the next program year (except Closures Calendar dates). To migrate profile information to the next program year, the Provider Portal user will click the Create 2019 button. In this example, the provider is migrating profile information from the 2018-2019 program year to the 2019-2020 program year. All information from the 2018-2019 profile will migrate to the 2019-2020 profile, with the exception of the Closures Calendar. The provider can also skip a profile year and still be able to create a profile for the current year. For example, the provider had a 2017-2018 profile, but skipped the 2018-2019 profile. In order to create a 2019-2020 profile, the provider will go to the 2017-2018 profile, click the Create 2018 button, then go to the 2018-2019 profile, and click the Create 2019 button. The skipped profile 2018-2019 can remain Incomplete.

After a provider is active, a Provider Portal User can edit the Provider Profile, by clicking the Profile dropdown menu and then clicking the Provider Profile button.

Provider Portal users can manage School Readiness and VPK contracts from the Provider Dashboard.
Provider Portal users can manage School Readiness and VPK enrollments from the Provider Dashboard.

Provider Portal users can manage School Readiness and VPK attendance, as well as view reimbursement details for paid attendance rosters, from the Provider Dashboard.

Provider Portal users can click the Documents dropdown menu to access the Document Library Management function and view and upload additional documents for coalition review.
Managing Contracts

Provider Portal users can view contract statuses and edit/download contracts through the Manage Contracts function.

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contact Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>View Contract</th>
<th>Start Date</th>
<th>End Date</th>
<th>Termination Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>VPK-APF</td>
<td>VPK 10, 11A, 11D</td>
<td>ELC of Palm Beach</td>
<td>Coalition Revisiting</td>
<td>04/01/2017</td>
<td>View</td>
<td>07/01/2017</td>
<td>07/01/2018</td>
<td>06/30/2018</td>
<td></td>
</tr>
<tr>
<td>139</td>
<td>VPK</td>
<td>DEL-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>03/25/2017</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td>06/26/2017</td>
<td></td>
</tr>
<tr>
<td>157</td>
<td>VPK</td>
<td>DEL-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>03/25/2017</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td>06/26/2017</td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>VPK</td>
<td>DEL-VPK 20</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>03/25/2017</td>
<td>View</td>
<td>07/01/2017</td>
<td>06/30/2018</td>
<td>06/26/2017</td>
<td></td>
</tr>
<tr>
<td>25733</td>
<td>SR</td>
<td>Contract Lite</td>
<td>DEL</td>
<td>Terminated</td>
<td>04/25/2017</td>
<td>Download</td>
<td>01/16/2017</td>
<td>01/16/2019</td>
<td>04/26/2017</td>
<td></td>
</tr>
<tr>
<td>25731</td>
<td>SR</td>
<td>Contract Lite</td>
<td>DEL</td>
<td>Terminated</td>
<td>04/25/2017</td>
<td>Download</td>
<td>01/16/2017</td>
<td>01/16/2019</td>
<td>04/26/2017</td>
<td></td>
</tr>
<tr>
<td>26708</td>
<td>VPK-SS3</td>
<td>Contract lite</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>01/16/2017</td>
<td>Download</td>
<td>01/16/2017</td>
<td>01/16/2019</td>
<td>04/26/2017</td>
<td></td>
</tr>
<tr>
<td>25804</td>
<td>VPK-SS3</td>
<td>Contract lite</td>
<td>ELC of the Big Bend Region</td>
<td>Terminated</td>
<td>04/25/2017</td>
<td>Download</td>
<td>01/16/2017</td>
<td>01/16/2019</td>
<td>04/26/2017</td>
<td></td>
</tr>
</tbody>
</table>

Managing Documents

Documents can be added to the Document Library for coalition review. The folder list within the Document Library is standard for all providers, but coalitions have the ability to re-name or add new folders. Documents uploaded to the Documents tab of the provider profile will also populate in the Document Library; however, documents uploaded to the Document Library will not populate in the Documents tab of the provider profile.

To view or upload documents in a folder, the provider portal user will click the View Files or Upload New File button, respectively.
Add New File

Select a document to upload.

- Select the folder from the drop down list to which you would like to upload a file to.
- Click the Browse... button to browse your documents and select the one that you want to upload to the folder.
- You may give a description to the file you are uploading.

Upload file to site: Jim's House of Learning 2

Select Destination Folder

Contracts

Select File

Browse

Attach your document.

Click the Attach Selected Document button below to upload the selected document to your selected folder. This will upload a copy of your document and store it in the chosen folder. The upload process may take from several seconds to a minute, depending on the size of the document and the speed of your internet connection.

Attach Selected Document
Provider Portal users can move within the Document Library by clicking the Change Folder dropdown menu. Files can also be renamed within each folder by clicking the Rename File button.

Enter the new file name in the New File Name field and click the Save Changes button to continue.
A Frequently Asked Questions pop-up message is available for the Provider Portal user. Contact the local early learning coalition if additional help is needed.

Frequently Asked Questions

How do I create a new folder?
A: Folders can only be created by your Coalition. In case you need to add files that cannot be assigned to one of the pre-defined folders please put them in the ‘Miscellaneous’ folder. Call your coalition for further information.

How do I upload files to a folder?
A: Click ‘Upload New File’ button which will open a dialog box that allows you to upload a file to a folder you select.

If I misspelled a word when naming a file, how can I correct it?
A: Files can be renamed from the ‘Folder Details’ screen. Click on the ‘View Files’ button to navigate to the ‘Folder Details’ screen, here you have to click on the ‘Rename File’ button that would open a dialog box that allows you to select the Folder and the files within it that you wish to rename.

Note: You can only change the name of an existing file and not its type or extension.

What format does a document have to be in to be uploaded?
A: Any of the following formats are permitted: .bmp, .tiff, .pdf, .jpg, .gif, .png, .doc, .docx, .txt

Is there a size limit on the documents to be uploaded?
A: A file’s size cannot exceed 2MB.

Who can I contact for technical assistance?
A: Please call your coalition office for any further assistance.coalition map

How could I retrieve an archived file?
A: Please call your coalition office for any further assistance with this.

How can I reduce the size of my document?
A: To reduce the size of a PDF, print the file using Adobe PDF as the printer, select the smallest file size option under the Default Settings menu and click OK on all open dialog boxes. The PDF is then converted to a smaller file. Upon completion, save the new file.

Close
Provider Contracting

**NOTE:** Provider contracts are populated by information in the Active profile. As a result, the profile is read-only once the contract status is **Initiated**, **Incomplete**, or **Submitted**. If any changes need to be made to the Active profile after a contract is **Initiated** or there is an error found in the profile once the contract is being edited (the contract status is **Incomplete**), contact your early learning coalition.

SR Contract

After the coalition has initiated an SR contract, the Provider Portal user will click **Manage Contracts** from the Provider Dashboard.

The following will display. Click the **Edit** button.
Provider Eligibility, Responsibilities and Scope of Work, Notification

After clicking the Next Step button, the following will display. Review the options in the dropdown menus, and click Next Step to continue.

Provider(s):
1. Golden Gate Community Center

II. PROVIDER ELIGIBILITY

II.7.f  The COALITION has determined the PROVIDER is exempt from the program assessment requirement pursuant to Rule 6M-4.740, F.A.C.  [No]
II.8.a  The Coalition participates in the Contracted Slots Program.  [Yes]
II.8.c  The COALITION has determined the PROVIDER eligible to participate in the Contracted Slots Program  [No]

III. PROVIDER RESPONSIBILITIES AND SCOPE OF WORK

III.32. If applicable, the eligible PROVIDER, agrees to conduct child assessments using a reliable assessor as defined by the child assessment tool, that meet the criteria described in s. 1002.82(k), F.S., at least three times per year and will submit valid and reliable data to the statewide information system.

XI. NOTIFICATION

XI.82.a  The representative for PROVIDER for the purposes of this Contract is Audrey Martinez who can be contacted at (239) 252-4055 or by email at audrey.martinez@co.fort.my.gov

Quality Improvement Plan Selection

After clicking the Next Step button, the following will display. Enter the user’s initials in each box below a check mark, and click Next Step to continue.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Strategy</th>
<th>Description (summary)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Coalition approved strategy</td>
<td>Each selected instructor/director will register for and successfully complete 20 hours of International Association for Continuing Education &amp; Training (IACET) approved training (or other OEL-Approved CEU training) provided by the ELC or their delegate.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Certified Coaching Visits</td>
<td>Each selected classroom will participate in 20 hours of certified coaching provided by the ELC or its delegate.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Early Childhood Training System (ECTS) Courses</td>
<td>Each selected instructor/director will complete two Early Childhood Training System courses facilitated by the ELC. Course options include taking an online course alone, with TA coaching support and/or as a member of a coalition-sponsored Community of Practice.</td>
</tr>
<tr>
<td>[ ]</td>
<td>20 hours of IACET- or OEL- approved training</td>
<td>Each selected instructor/director will register for and successfully complete 20 hours of International Association for Continuing Education &amp; Training (IACET) approved training (or other OEL-Approved CEU training) provided by the ELC or their delegate.</td>
</tr>
<tr>
<td>[ ]</td>
<td>MMCI Training</td>
<td>Each selected instructor/director will complete either the MMCI PreK 24-hour course or the MMCI Infant/Toddler 24-hour course provided by the Coalition's or its delegate's MMCI Specialist.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Professional Development</td>
<td>Each selected instructor/director shall register in the Florida Early Care and Education Professional Development Registry, generate a professional development plan in the registry and complete the required progression along the career pathway.</td>
</tr>
</tbody>
</table>
Exhibit 5: Provider Reimbursement Rates

If the provider charges an annual registration fee (Profile menu > Provider Profile > Fees & Discounts), the following will display. Select the annual fee details and click Next Step to continue.

Exhibit 6: Holiday Schedule

After clicking the Next Step button, the following will display. The dates listed are based on the closure dates from the profile Closure Calendar tab and includes any coalition-defined holidays.

If fewer dates are listed than the coalition maximum total paid closure dates, additional provider holidays can be added to the holiday schedule exhibit, if applicable. Click the Edit button on the holiday table.
After clicking the **Edit** button, a pop-up window appears with an editable holiday table. On a blank row, enter the holiday name, then select a date from the dropdown in the Date Observed column. Duplicate dates cannot be used. Click **Save**. Click **Next Step** to continue.

**Preview Contract**

Prior to executing the contract, click **Preview Contract** to view the contract. This allows the user to view all the information input into the contract from the profile, in addition to exhibits. Information from the above sections, added by the coalition when the contract is initiated, should be reviewed as well.
After clicking the **Preview Contract** button, the following will display.

Contract Execution

After clicking the **Next Step** button, the following will display. To electronically sign the contract, check the **By Electronic Signature** checkbox.

**NOTE FOR PUBLIC SCHOOLS:** If a school board or school district needs to manually sign a contract (instead of an electronic signature), the contract can be submitted without an electronic signature, then downloaded as a .pdf and printed.
After clicking the checkbox, the following message will display. Enter the **Title of Signator** and click **Yes**.

**NOTE:** The **Title of Signator** is not the provider’s name, but the business title, e.g. Owner, Director, Principal.

![Form OEL-SR 20 Electronic Signature](image)

**You are about to electronically sign the** Form OEL-SR 20.

**Title of Signator:** [ ]

Click “Yes” to confirm your electronic signature.

After clicking the **Yes** button, the electronic signature of the signatory and the date/time will populate in yellow. Click **Next Step** to continue.

**NOTE:** The electronic signature and printed name of the Provider Portal user is based on the user who is logged on to the portal. Please ensure that the proper Provider Portal user is logged on to electronically sign the contract. If the incorrect name is used for the electronic signature, the checkbox can be un-checked.

![Form OEL-VPK 20 Electronic Signature](image)

**You are about to remove your signature from the** Form OEL-VPK 20.

Click “Yes” to continue.
<table>
<thead>
<tr>
<th>Title</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>6/8/2020 1:00:34 PM</td>
</tr>
<tr>
<td>Print Name</td>
<td></td>
</tr>
<tr>
<td>Signature of President/Principal/Owner/Principal/Other Authorized Representative</td>
<td></td>
</tr>
<tr>
<td>Print Name</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Date</td>
</tr>
<tr>
<td>Provider's Additional Signature (If required by the Provider)</td>
<td></td>
</tr>
<tr>
<td>Print Name</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Date</td>
</tr>
<tr>
<td>Signature of Authorized Coalition Representative</td>
<td></td>
</tr>
<tr>
<td>Print Name</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Date</td>
</tr>
</tbody>
</table>
Contract Certification

After clicking the **Next Step** button, the following will display. Enter the full name of the Provider Portal user who is logged on, title, and click the **Certified by electronic signature** checkbox. Click **Submit**.

After clicking the **Submit** button, the following message will display and an email will be sent by DONOTREPLY@OEL.myflorida.com.
The SR contract will have a status of **Submitted**.
VPK Contract

After the coalition has initiated a VPK contract, the Provider Portal user will click **Manage Contracts** from the Provider Dashboard.

The following will display. Click the **Edit** button.

```
Provider(s):

VII COMPENSATION AND FUNDING

Advance Payment Option

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contract Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>View Contract</th>
<th>Effective Date</th>
<th>Termination Date</th>
<th>Program Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>45939</td>
<td>VPK</td>
<td>OEL-VPK 20</td>
<td>ELC of Southwest Florida</td>
<td>Certified</td>
<td>2/10/2020</td>
<td>▼ View</td>
<td></td>
<td>1/26/2020</td>
<td>2019 - 2020</td>
<td></td>
</tr>
<tr>
<td>42516</td>
<td>VPK</td>
<td>OEL-VPK 20</td>
<td>ELC of Southwest Florida</td>
<td>Certified</td>
<td>2/19/2020</td>
<td>▼ View</td>
<td></td>
<td>7/1/2019</td>
<td>2019 - 2020</td>
<td></td>
</tr>
<tr>
<td>39927</td>
<td>VPK</td>
<td>OEL-VPK 20</td>
<td>ELC of Southwest Florida</td>
<td>Terminated</td>
<td>4/6/2020</td>
<td>▼ View</td>
<td></td>
<td>7/1/2019</td>
<td>2019 - 2020</td>
<td></td>
</tr>
<tr>
<td>14203</td>
<td>VPK, APP</td>
<td>VPK 10,11A,11B</td>
<td>ELC of Southwest Florida</td>
<td>Certified</td>
<td>2/10/2020</td>
<td>▼ View</td>
<td></td>
<td>8/26/2019</td>
<td>2019 - 2020</td>
<td></td>
</tr>
</tbody>
</table>
```

Advance Pay Options

After clicking the **Edit** button, the following will display. Review the Advance Payment Options in the dropdown menus, and click **Next Step** to continue.
Exhibit 1: Provider Location List

After clicking the **Next Step** button, the following will display. Select the School Year and/or Summer checkboxes and click **Next Step** to continue.

---

**Preview Contract**

Prior to executing the contract, click **Preview Contract** to view the contract. This allows the user to view all the information input into the contract from the profile, in addition to exhibits and attachments. Information from the above sections, added by the coalition when the contract is initiated, should be reviewed as well.
After clicking the **Preview Contract** button, the following will display.

STATE OF FLORIDA  
STATEWIDE VOLUNTARY PREKINDERGARTEN PROVIDER  
CONTRACT  
FORM OEL-VPK 20

1. **PARTIES AND TERMS OF CONTRACT**

   1. **Parties.** This Contract is made and entered into this __th__ day of __April__ 20__, by and between the Early Learning Coalition of __Southwest Florida__ (hereafter referred to as “COALITION”), and ________________________ (hereinafter referred to as “PROVIDER”), with its principal office located at ______________________ and its provider physical site address (if the single site provider physical site address is different from principal office address) located at ______________________

      a. **Multiple Public School Locations.** If PROVIDER is a school district executing a single Contract on behalf of multiple public school Voluntary Prekindergarten (VPK) Education Program providers, a list of their names and their physical addresses are included in Exhibit 1: Provider Location List. Thereafter PROVIDER shall include each entity listed in Exhibit 1.

      b. **Multiple Private Provider Locations.** If PROVIDER is executing a single Contract on behalf of multiple private VPK provider sites within COALITION’s service area, a list of their names and their physical addresses are included in Exhibit 1: Provider Location List. Thereafter PROVIDER shall include each entity listed in Exhibit 1.

      c. **Identification Number.** Insert PROVIDER’S ☐ EIN ☒ SSN here: ________________

         PROVIDER’s EIN (Employer Identification Number) or SSN (Social Security Number) is requested in accordance with s.110.071(5)(b) and 119.002, F.S., for use in the records and data systems of the Office of Early Learning and COALITION. Submission of PROVIDER’s EIN or SSN is mandatory. PROVIDER’s EIN or SSN will be used for processing payments to PROVIDER as a VPK provider, for reporting those payments for federal tax purposes, and for routine identification.

   2. **Purpose.** This Contract is designed to inform PROVIDER of the requirements of participation in the VPK Program. Payment is not conveyed to PROVIDER through this Contract. Instead, PROVIDER must agree to comply with the terms and conditions of this Contract in order to be
Contract Execution

After clicking the **Next Step** button, the following will display. To electronically sign the contract, click the **By Electronic Signature** checkbox.

**NOTE FOR PUBLIC SCHOOLS:** If a school board or school district needs to manually sign a contract (instead of an electronic signature), the contract can be submitted without an electronic signature, then downloaded as a .pdf and printed.

After clicking the checkbox, the following message will display. Enter the **Title of Signator** and click **Yes**.

**NOTE:** The **Title of Signator** is not the provider’s name, but the business title, e.g. Owner, Director, Principal.
After clicking the **Yes** button, the electronic signature of the signatory and the date/time will populate in yellow. Click **Next Step** to continue.

**NOTE:** The electronic signature and printed name of the Provider Portal user is based on the user who is logged on to the portal. Please ensure that the proper Provider Portal user is logged on to electronically sign the contract. If the incorrect name is used for the electronic signature, the checkbox can be un-checked.
Contract Certification

After clicking the **Next Step** button, the following will display. Enter the full name of the Provider Portal user who is logged on, title, and click the **Certified by electronic signature** checkbox. Click **Submit**.

After clicking the **Submit** button, the following message will display and an email will be sent by DONOTREPLY@OEL.myflorida.com.
The VPK contract will have a status of **Submitted**.
The VPK-APP replaces forms OEL-VPK 10 (Provider Application), OEL-VPK 11A (Class Registration – Instructors), and OEL-VPK 11B (Class Registration – Calendars). The tabs must be done in order of appearance (Attendance Policy, then VPK Director, etc.); the answers in one tab populate information in the next tab.

After the coalition has initiated the provider application, the Provider Portal user will click Manage Contracts from the Provider Dashboard.

The following will display. Click the Edit button to review the contract.

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contract Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>View Contract</th>
<th>Start Date</th>
<th>End Date</th>
<th>Termination Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>44</td>
<td>VPK-APP</td>
<td>VPK 10.11A.11B</td>
<td>ELC of North Florida/Episcopal Children’s Services</td>
<td>Initiated</td>
<td>4/20/2020</td>
<td>Download</td>
<td></td>
<td>7/1/2020</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Step 1 – Attendance Policy**

The Attendance Policy tab allows the Provider Portal user to upload the provider Attendance Policy. The document that is to be distributed to parents must be uploaded by clicking the Browse button, finding the document in the electronic files and clicking the Upload button.
Step 2 – VPK Director

The VPK Director tab allows the Provider Portal user to add information and upload documents for the primary VPK Director that will be listed on the OEL-VPK 10. Click the **Add New Director** button to begin.

Click the **Save** button after all information is entered for the director.

**NOTE:** The Credential Type, Credential Certificate Number, Credential Issue Date, and Credential Expiration Date will not appear for public schools.

Once the VPK Director is added, the supporting documents may be added by clicking **Edit**.
The Provider Portal user will select the document type, browse to select a file, enter the document issue or expiration date (if applicable), and click **Upload**. Then, click **Save**. At least one document should be uploaded.

### Step 3 – VPK Instructors

The VPK Instructors tab allows the Provider Portal user to add information and upload documents for each instructor. Click the **Add New Instructor** button to begin.

Click the **Save** button after all information is entered for each instructor.
Once the VPK Instructor is added, the supporting documents may be added by clicking Edit.

The Provider Portal user will select the document type, browse to select a file, enter the document issue or expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.

**NOTE:** If a VPK Instructor achieves new certifications and moves from a sub to an aide, create a new record for that Instructor. If the Instructor Type is only changed from sub to aide, the maximum class size will not increase to 20 in a class that already has a Lead Instructor.

**Step 4 – VPK Calendars**

The VPK Calendars tab allows the Provider Portal user to provide information regarding each unique class calendar which will be offered at the VPK site. If classes are offered at identical times on identical dates, they utilize the same class calendar (e.g., all classes are scheduled from 8:00am to 11:00am, Monday through Friday, starting on January 11). If classes are not offered at identical times on identical dates, they utilize unique class calendars which must be created separately. Click the Add New Calendar button to begin.

The Calendar ID will automatically populate with a letter beginning with A. Each additional calendar will receive a sequential Calendar ID.

The Calendar Name is an optional field. It may be used for a short nickname such as “Fall AM.”
The program type selection of School-Year (540 hours) or Summer (300 hours) is required. The program selected will determine the valid calendar date range. The Calendar Start Date and Calendar End Date must be within the valid calendar date range. The Calendar Start Date and Calendar End Dates should reflect the first day VPK instruction will be delivered and the final day VPK instruction will be delivered.

Next, the instructional days, start time and end time must be added by checking the box by the days of the week that VPK instruction will be delivered and entering the times of VPK instruction for the days of the week that VPK instruction will be delivered.

After the instructional days, start time and end time are added, the Total Calculated Hours and Total VPK Instructional Days sections will populate.

Providers are to use the calendar to note any non-instructional days on which VPK instruction will not be delivered (such as vacations or holidays) and exceptions to normal instructional days that occur during the defined calendar start and end date. Entering Non-Instructional Days and Instructional Day Exceptions can increase or decrease the Total Calculated Hours.
For example, if the Total Calculated Hours exceed 300 hours for the summer program type or 540 hours for the school-year program type (as shown in the example above), the user may remove a day (or more) by labeling it a Non-Instructional Day. Each Non-Instructional Day entered will deduct the hours assigned to that day, thereby decreasing the Total Calculated Hours. Instructional Day Exceptions can be used to change the hours assigned to that day (to increase or decrease the hours). For example, if the calendar is a few hours short, an instructional day’s hours may be extended to increase the Total Calculated Hours. To add a Non-Instructional Day or an Instructional Day Exception to the calendar, click on that date on the calendar. Multiple days can be selected by clicking and dragging across multiple days on the calendar.

After clicking on a date, a pop-up message will appear. The Provider Portal user must select the Event Type and enter a short description. When an Instructional Day Exception is selected, the user must also enter the time range for the day.

Click the Update button to save changes. Click the Remove button to remove an existing Non-Instructional Day or Instructional Day Exception created on the calendar.
When the Total Calculated Hours match the hours for the VPK program type, the user will click the **Save** button.

**NOTE:** The hours must equal, or be fewer than, 300 hours for the summer program type or 540 hours for the school-year program type for the calendar to save.
Step 5 – VPK Class(es)

The VPK Class(es) tab allows the Provider Portal user to build VPK classes and assign instructor(s) to them. Click the Add New Class button to begin.

The Class ID will automatically populate after the Class Calendar is selected. The Class ID is created using a sequential letter beginning with A. In the second space, either an “F” for school-year (fall) or “S” for summer will appear. The F and S is derived from the calendar’s program type. The last two digits represent the last two numbers of the program year. Each additional class will receive a sequential Class ID.

The Class Name is an optional field. It may be used for a short nickname such as “Blue Room.”

The Main Curriculum drop down is populated with selections made from the provider’s profile.

The Class Start Date and Class End Date are populated with the Calendar Start Date and End Date.

The Instructors are populated with individuals from the VPK Instructors tab. Check the checkbox in front of the instructor to add them to the class, then enter the Instruction Start Date. If the class has not started, the Instruction Start Date defaults to the Class Start Date. For each class, one Lead Instructor must be selected. Click the Save button after all information is entered for each class.
**Step 6 – Review**

During the review process, the Provider Portal user can click the **Edit** button to make any changes to a section. After reviewing the information for each section, the user must click the **Certify and Submit** tab button to continue.

<table>
<thead>
<tr>
<th>Column ID</th>
<th>Calendar Name</th>
<th>Program Type</th>
<th>Start Date</th>
<th>End Date</th>
<th>Total Calendar Days</th>
<th>Non-Work Calendar Days</th>
<th>Sick Calendar Days</th>
<th>Total Calendar Days</th>
<th>Total Worked Hours</th>
<th>Total Worked Hours (Alert if exceed 50)</th>
<th>Total (if exceed 100)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>School Year (Full Year)</td>
<td>09/01/2018</td>
<td>05/31/2019</td>
<td>180</td>
<td>180</td>
<td>180</td>
<td>0</td>
<td>180</td>
<td>180</td>
<td>180 (Alert if exceed 50)</td>
<td>180 (if exceed 100)</td>
</tr>
<tr>
<td>2 (Part Time)</td>
<td>School Year (Half Year)</td>
<td>09/01/2018</td>
<td>05/31/2019</td>
<td>90</td>
<td>90</td>
<td>90</td>
<td>0</td>
<td>90</td>
<td>90</td>
<td>90 (Alert if exceed 50)</td>
<td>90 (if exceed 100)</td>
</tr>
</tbody>
</table>
Step 7 – Certify and Submit

To submit the VPK-APP, the Signer’s Name must exactly match the name entered in the Provider Profile, the Provider Portal user must fill in the phone number, check the “Check box to certify by electronic signature” check box and click the Submit VPK Provider Application button.

Certify and Submit

By signing this form I certify that:

- To the best of my knowledge and belief, the information provided is true and correct.
- If any information changes, I (PROVIDER) will notify the COALITION within 14 days of the change.
- I understand that if changes implemented prior to receipt of COALITION approval may result in noncompliance with VPK requirements.
- Each VPK instructor hired has submitted an attestation of good moral character, has provided documentation to be maintained in the files of the PROVIDER/DISTRICT and the COALITION documenting that the individual has undergone a Level 2 background screening within the previous five (5) years in accordance with section 418.94, F.S., which demonstrates that the individual is not ineligible to act as a VPK instructor; and is not ineligible to teach in a public school because the instructor’s educator certificate has been suspended or revoked.
- Each credentialed VPK instructor listed has the credentials required for the VPK program.
- I understand that my information will be shared with the Department of Children and Families, Office of Child Care Regulation, for inclusion in the CARES system.

You Have Successfully Completed and Submitted your VPK Provider Application!

Congratulations, you have successfully submitted your VPK Provider application.

Your early learning coalition will process your application.

Please check your email for important information about your application.

From here you can:

Return to dashboard

Log off
Updating a VPK-APP

A Provider Portal user can edit a VPK-APP by clicking the **Edit** button on their Manage Contracts page. Clicking the **Download** button will export the information in the VPK-APP to a .pdf document.

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Type of Contract</th>
<th>Contract Name</th>
<th>Coalition</th>
<th>Status</th>
<th>Last Updated</th>
<th>Action</th>
<th>VPK Start Date</th>
<th>VPK End Date</th>
<th>Termination Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>45</td>
<td>VPK-APP</td>
<td>VPK 10,11A,11B</td>
<td>ELC of Palm Beach</td>
<td>Certified</td>
<td>06/27/2017</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VPK Director

To edit the current director’s information in the VPK Director tab, click the **Edit** button. To remove a director, click the **Remove** button. To add a new director, click the **Add New Director** button. To edit the current supporting document, or add a new document, click the **Edit** button.

When the **Remove** button is clicked, the following message will display.

**Remove Not Jim Ledbetter?**

⚠️ You are about to remove this director and make him/her inactive. All information and documents (if any) will be retained. You may re-add this director at a later time if needed. To continue, enter the last day this individual served as VPK Director and click Remove, otherwise click Cancel.

Enter or Select Date

Once the director’s last day is entered and the **Remove** button is clicked, the director will no longer appear on the VPK Director screen, unless the **Show removed directors** checkbox is checked. The director can be re-added by clicking the **Re-add** button.
VPK Instructors

To edit the current instructors’ information in the VPK Instructors tab, click the **Edit** button. To add a new instructor, click the **Add New Instructor** button. To remove an instructor, click the **Remove** button. To edit the current supporting document(s), or add a new document, click the **Edit** button.

If the instructor has not been assigned to a class, when the **Remove** button is clicked, the following message will display.

⚠️ Remove Not Jim Ledbetter?

You are about to remove this instructor and make him/her inactive. All information and documents (if any) will be retained. You may re-add this instructor at a later time if needed. To continue, click Remove, otherwise click Cancel.
Once the **Remove** button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the **Show removed class instructors** checkbox is checked. The instructor can be re-added by clicking the **Re-add** button.

If the instructor has been assigned to a class, when the **Remove** button is clicked, the following message will display.

**Instructor is currently assigned**

![Warning message](image)

**This action cannot be performed because the instructor is currently assigned to a class. Please remove the instructor from all classes first.**

To remove an instructor from a class, go to the VPK Class(es) section and click the **Edit** button for the class.
In the Instructors area, uncheck the instructor’s name. Once un-checked, enter the Last Taught Date, or click the Never began instruction of class checkbox if the class has not started. Click Save.

The VPK Classes tab will now show that the instructor is removed from the class.

Now that the instructor is no longer assigned to any class, the Provider Portal user may go to the VPK Instructors tab to remove the instructor by clicking Remove. The following message will display:

You are about to remove this instructor and make him/her inactive. All information and documents (if any) will be retained. You may re-add this instructor at a later time if needed. To continue, click Remove, otherwise click Cancel.
Once the **Remove** button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the **Show removed class instructors** checkbox is checked. The instructor can be re-added by clicking the **Re-add** button.

The Review tab is also updated with the Instructor removal information.
VPK Calendars

To edit the current calendar in the VPK Calendars tab, click the Edit button, make any necessary edits, and click the Save button. To remove a calendar, click the Remove button. To add a new calendar, click the Add New Calendar button.

If there are no classes assigned to a calendar, when the Remove button is clicked, the following message will display:

Remove ?

You are about to remove this calendar and make it inactive. You may re-add this calendar at a later time if needed. Are you sure you want to remove this calendar?

If there are classes assigned to a calendar, the following message will display:

Calendar is currently assigned

This action cannot be performed because the calendar is currently assigned to a class. If the class has not started yet, you may remove the calendar from the class and try this action again.

89
Once a calendar is removed, the calendar will no longer appear on the VPK Calendars screen, unless the **Show removed calendars** checkbox is checked. The calendar can be re-added by clicking the **Re-add** button.

**NOTE:** Calendar End Dates and Class End Dates are editable.

The Calendar End Date can be changed to reflect changes in Non-Instructional Days or holidays that are added after the calendar begins. Changing the Calendar End Date will update the Class End Date and the Instructor Last Taught Date.
After the calendar is changed, if the provider needs to change the Instruction Start Date of an instructor, the provider will un-check and re-check the checkbox for each instructor and edit the date.
The Calendar Name can be added if the provider did not add a Calendar Name when the calendar was created.
VPK Class(es)

To edit the current class information in the VPK Class(es) tab, click the **Edit** button. To add a new class, click the **Add New Class** button. To remove a class, click the **Remove** button. After all edits have been made for each class, click the **Save** button.

Classes that have started may not be removed. Limited editing is available.
If the class has not started, when the **Remove** button is clicked, the following message will display:

Are you sure you want to remove this classroom?

Once the **Remove** button is clicked, the class will no longer appear on the VPK Class(es) screen, unless the **Show removed classes** checkbox is checked.
To end the class, click the **Edit** button and change the Class End Date to reflect the last day that VPK instruction was provided. The Instructor Last Taught Date will be updated to the Class End Date after clicking the **Save** button.

The Review tab will now reflect the updated class information.
Editing an SR Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page for the provider displays. Click the plus sign (1) to the left of the SR contract to be amended to expand the amendment sub-section. The amendment is in Initiated status. Click the Edit button (2).

NOTE: The amendment status changes from Initiated to Incomplete while the amendment is being edited.
Review the Provider Eligibility and Notification sections, and enter changes to the provider contact information (if applicable), then click **Next Step**.

Initial the Quality Improvement Plan strategy, if applicable. Click **Next Step**.
The Exhibit 6: Holiday Schedule page displays. Click the **Edit** button for the provider and add or remove holidays in the edit window if applicable, then click **Save**. Click **Close** to close the window.

To proceed to the next page, click **Next Step**.
On the Amendment Signatures page, click the box to sign the amendment electronically. Provider may want to preview the OEL-SR 20A form to verify changes before signing and submitting.

When the electronic signature box is checked, a pop-up window displays. Enter the Title of Signator, then click **Yes** to proceed with electronically signing the amendment, or click **Cancel** to close the window without signing.
When **Yes** is clicked, the signator’s signature, printed name, title and the date are populated and saved. Click **Submit**.

**NOTE:** To add an additional signature, click **Cancel** and have the other Signator log in to sign the amendment before submitting. To remove the provider’s signature before submitting the amendment, uncheck the By Electronic Signature box and click **Yes** in the confirmation pop-up window.
Enter Full Name and Title, then click the “Certified by electronic signature box.” Click **Submit**.

The successfully completed, signed, certified, and submitted message appears.
Viewing a Certified SR Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page displays. Click the plus sign (1) to the left of the SR contract that was amended to expand the amendment sub-section. The amendment is in **Certified** status. Click View (2).

The OEL-SR 20A opens in a new tab to view and print to PDF.
Editing the VPK Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page for the provider displays. Click the plus sign (1) to the left of the VPK contract to be amended to expand the amendment sub-section. The amendment is in **Initiated** status. Click **Edit** (2).

NOTE: The amendment status changes from **Initiated** to **Incomplete** while the amendment is being edited.
Select an advance payment option for the school year and summer programs, then click Next Step.

**NOTE:** In a future release, the advance payment options will default to the current selections, and the provider will not be required to choose an option if it has not changed.

If a provider is being added to or removed from the contract, the Exhibit 1 Provider Location List Attachment displays. Select school year and summer as applicable, then click Next Step.
On the Amendment Signatures page, click the box to sign the amendment electronically. Provider may want to preview the OEL-VPK 20A amendment to verify changes before signing and submitting.

When the electronic signature box is checked, a pop-up window displays. Enter the Title of Signator, then click Yes to proceed with electronically signing the amendment, or click Cancel to close the window without signing.
When **Yes** is clicked, the signator’s signature, printed name, title and the date are populated and saved. Click **Submit**.

**NOTE:** To add an additional signature, click **Cancel** and have the other Signator log in to sign the amendment before submitting. To remove the provider’s signature before submitting the amendment, uncheck the By Electronic Signature box and click **Yes** in the confirmation pop-up window.

Enter Full Name and Title, then click the “Certified by electronic signature box.” Click **Submit**.
The successfully completed, signed, certified, and submitted message appears.

Viewing a Certified VPK Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page displays. Click the plus sign (1) to the left of the VPK contract that was amended to expand the amendment sub-section. The amendment is in Certified status. Click the View button (2).

The OEL-VPK 20A opens in a new tab to view and print to PDF.
Enrollments - VPK

VPK Providers may manage VPK enrollment online by going to Enrollments> Manage VPK Enrollments. Two options are available: Request/Change Enrollment and Bulk File Upload.

Request/Change Enrollment

This feature allows VPK Providers to request or change enrollment for children in verified classes submitted through the VPK Provider Application. To begin, select the VPK Program Year, VPK Session, and VPK Class.

With the VPK Program Year, VPK Session, and VPK Class selected, the class start date and end date appear as well as the max class size. This information is directly tied to the VPK Provider Application. For example, if there is one lead instructor for the school-year session submitted and verified on the VPK Provider Application, the max class size will be 11; if there are two instructors for the school-year session submitted and verified on the VPK Provider Application, the max class size will be 20.

Next, the VPK children count and Non-VPK children count are displayed. These two counts (summed together) cannot exceed the max class size. The Non-VPK children count is used to anonymously indicate private pay children participating in the VPK class. The Non-VPK children count defaults to zero. When the Non-VPK children count is used, the number of VPK children permitted in the class is reduced to maintain the max class size limit.
The class roster records are also displayed. If there are no children enrolled in the class, a "No records found for this class" message displays.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Certificate Number</th>
<th>Child First Name</th>
<th>Child Last Name</th>
<th>Child DOB</th>
<th>Child Age</th>
<th>Student ID</th>
<th>Anticipated Start Date</th>
<th>Actual Start Date</th>
<th>Termination Effective Date</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enroll</td>
<td>VPK17359-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>09/05/2019</td>
<td>9-10</td>
<td>09/05/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK16980-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>09/05/2019</td>
<td>9-10</td>
<td>09/05/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK16378-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>08/30/2019</td>
<td>9-10</td>
<td>08/30/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK16383-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>08/30/2019</td>
<td>9-10</td>
<td>08/30/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK15056-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>08/12/2019</td>
<td>9-10</td>
<td>08/12/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK14277-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>08/12/2019</td>
<td>9-10</td>
<td>08/12/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
<tr>
<td>Enroll</td>
<td>VPK13988-2019</td>
<td></td>
<td></td>
<td>4y</td>
<td>08/12/2019</td>
<td>9-10</td>
<td>08/12/2019</td>
<td></td>
<td></td>
<td>Enrolled</td>
</tr>
</tbody>
</table>

If there are/were children enrolled in the class, the records are listed with the current enrollment status (Enrolled, Enrolled-Change Requested, or Enrollment Ended (Terminated)).

Enrolling a VPK Child

Using the child’s approved Certificate of Eligibility (COE) provided by the family, enter the Certificate Number, Child First Name, Child Last Name, and Child DOB. Then, click Enroll to this Class.

NOTE: The fields are not case sensitive; however, the certificate number must be entered exactly as it appears on the COE (i.e. VPK####-YYYY).
The system verifies that the information entered matches a child with an approved COE for the VPK program year selected and that the child is not already enrolled (or in a non-eligible status for enrollment).

**NOTE:** The county on the COE does not have to match the provider’s county because the child has been deemed eligible to participate in the VPK program. The enrollment process automatically updates the child’s county for service to the provider’s county so the corresponding early learning coalition may manage the child’s enrollment with the provider.

When a matching child is found and validations checks are successful, a confirmation message appears. To continue, click **Yes**.

Next, the system asks for the Anticipated Start Date. This is the date the child will begin attending class. Typically, this is the class start date unless the child is starting after the class begins.

**NOTE:** An anticipated start date cannot be before the class start date or after the class end date. And, an anticipated start date cannot be before the child’s COE issue date (as displayed on the child’s COE and listed in the enrollment window).
The system validates each enrollment request to make sure the max class size is not exceeded (based on the number of instructors assigned, the VPK session type, and current class enrollment count). To continue, click **Enroll Child**.

When the enrollment request is successful, the child appears on the class’s enrollment roster as “Enrollment Submitted” and the coalition receives the enrollment request for review/approval/rejection. In addition, the family receives a notification that their child’s enrollment is in progress.

While the enrollment request is being processed by the coalition, the status is updated on the enrollment roster. For example, the coalition has changed the status to **Coalition Reviewing**.

If the coalition rejects or cancels the enrollment request, the child will no longer appear on the class roster. The VPK Director and family will receive an email notification. The family is instructed to download their child’s COE from the Family Portal and re-start the enrollment process.
When the enrollment process is approved by the coalition, the child’s status is Enrolled.

Managing VPK Enrollment
The class roster has several features for managing enrollment. Providers may change the anticipated start date, request to move the child to another class, remove the child entirely from the roster because they never attended, or request a termination of services.

*Change Anticipated Start Date*
To change the child’s anticipated state date, click **Change** within the Anticipated State Date column. A window displays. The current start date populates in the *From* field; enter the new start date in the *To* field. This feature does not require coalition approval. Click **Save** to commit the new date or click **Close** to abandon the date change and close the window. This feature is available until the actual start date is recorded through the attendance process. When the actual start date is populated in the column, the **Change** button is no longer available.

*Class Change*
Once the child’s status is *Enrolled*, a class change may be requested. To change the child’s class, click **Class Change** within the Actions column. A window displays. The current class populates in the *From* field; select the new class in the *To* field and enter the Transfer Effective Date. The Transfer Effective Date should be the first day the child will attend the new class. This feature requires coalition approval. Click **Submit Request** to send the request to the coalition or click **Close** to abandon the class change and close the window.
Now that the class transfer request is submitted, the child appears on the roster for both classes. In the *From* class, the child’s status is Enrolled.

In the *To* class, the child’s status is *Enrolled - Change Requested*.

When approved, the *From* class has a termination effective date (same as the transfer effective date). If the termination effective date has not passed, the status is Enrolled. When the termination effective date occurs, the status will be Enrollment Ended. No further actions can be taken on this enrollment.
When approved, the To class is Enrolled with an anticipated start date and actual start date (same as the transfer effective date).

**NOTE:** A class transfer request cannot be submitted for a child if the transfer effective date overlaps an existing enrollment period for that child. If the transfer effective date is BEFORE the termination effective date of the last enrollment, an error message appears, “The class transfer effective date overlaps an existing enrollment period for this child.”

When rejected, the request no longer appears in the To class. The child remains enrolled in the From class.

**Class Change to a Full Class**

If a provider wants to move a child from class BF18 to class AF18, but class AF18 is full, the class change can still be done.

Class BF18 is not full.

---

### Daisy Mae Daycare

<table>
<thead>
<tr>
<th>Certificate Number</th>
<th>Child First Name</th>
<th>Child Last Name</th>
<th>Child DOB</th>
<th>Child Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>VPK752-2018</td>
<td>Blue Fairy</td>
<td>Latham</td>
<td>08/01/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK753-2018</td>
<td>Cinderella</td>
<td>Latham</td>
<td>07/01/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK754-2018</td>
<td>Cecilia deVil</td>
<td>Latham</td>
<td>03/01/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK755-2018</td>
<td>Snow White</td>
<td>Latham</td>
<td>04/01/2014</td>
<td>4y</td>
</tr>
<tr>
<td>VPK756-2018</td>
<td>Dec</td>
<td>Latham</td>
<td>08/01/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK757-2018</td>
<td>Sloppy</td>
<td>Latham</td>
<td>10/12/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK758-2018</td>
<td>Happy</td>
<td>Latham</td>
<td>08/03/2013</td>
<td>5y</td>
</tr>
<tr>
<td>VPK759-2018</td>
<td>Sneazy</td>
<td>Latham</td>
<td>11/11/2013</td>
<td>5y</td>
</tr>
</tbody>
</table>
Class AF18 is full.

Daisy Mae Daycare

The provider wants to move Blue Fairy Latham to AF18 from BF18.

Change Child Enrollment

Certificate Number: VPK752-2018  Certificate Issue Date: 07/29/2018
Child Name: Blue Fairy Latham  Child Date Of Birth: 08/18/2013
Anticipated Start Date: 12/10/2018  Class ID: BF18 - Forest Room

Transfer Child Class

Coastal approval required

From: BF18 - Forest Room  To: --Select--

Transfer Effective Date: MM/DD/YYYY

Submit Request  Close
The provider selects AF18 in the To field and enters the Transfer Effective Date. Once the Submit Request button is clicked, the provider receives a red message.
Now, the provider can either select a class that is not full, or select a child to swap with in the full class. Click the **Submit Request** button to complete the class change.

**Change Child Enrollment**

<table>
<thead>
<tr>
<th>Certificate Number:</th>
<th>VP752-2018</th>
<th>Certificate Issue Date:</th>
<th>07/20/2018</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Child Name:</strong></td>
<td>Blue Fairy Latham</td>
<td><strong>Child Date Of Birth:</strong></td>
<td>08/08/2013</td>
</tr>
<tr>
<td><strong>Anticipated Start Date:</strong></td>
<td>12/10/2018</td>
<td><strong>Class ID:</strong></td>
<td>BF18 - Forest Room</td>
</tr>
</tbody>
</table>

**Transfer Child Class**

- **From:** BF18 - Forest Room
- **To:** AF18 - Flower Room
- **Transfer Effective Date:** 02/27/2019
- **Swap spot with enrolled child from selected class.**
- **Swap spot with:** Ariel Latham

Target class is full. Please choose a valid class or select the swap child feature.
Never Attended

To remove a child from a class completely because they never attended, click Never Attended within the Actions column. A window displays. This feature does not require coalition approval. Click Yes to remove the child or click No to abandon the removal and close the window. Removing an enrollment changes the record’s status to Enrollment Cancelled and the enrollment process starts over for the family. The provider’s VPK Director will receive an email notification to inform them the enrollment is removed; no attendance or reimbursement may be sought. The child’s record is no longer listed on the class enrollment roster or attendance roster in the Provider Portal. The family will receive an email notification to inform them the enrollment for their child was cancelled; instructions are provided to log into the Family Portal to download the child’s COE and select another VPK provider.

This feature is available until the actual start date is recorded through the attendance process. When the actual start date is populated in the column, the Never Attended button is no longer available.

NOTE: Be very careful with the Never Attended feature. If the intention is to transfer the child to a different classroom, use the Class Change feature. If the child attended class, VPK instructional hours were used, and reimbursement is needed, use the Terminate feature.
To terminate a child’s enrollment, click **Terminate** within the Termination Effective Date column. A window displays. Enter the last day that services will be rendered and select the reason for termination. The Termination Effective Date is displayed below the Last Day of Services as one day after the last day of services. Therefore, the Termination Effective Date is the first day the child is NOT attending class. This feature requires coalition approval. Click **Submit Request** to send the request to the coalition or click **Close** to abandon the termination request and close the window.

**NOTE:** A child’s enrollment cannot be terminated before the class start date. If the provider enters a date in the Last Day of Services that is BEFORE the class start date, an error message appears, “Termination effective date cannot be prior to the class start date. If the child never attended, click the **Never Attended** button to cancel the enrollment.” Either enter a termination date that is after the class start date (and on or after the COE issue date), or click **Close** to abandon the termination request and close the window.

When the termination request is submitted, the child appears on the class’s enrollment roster as “Enrolled - Change Requested.” The coalition will receive the termination request for review/approval/rejection.

When the termination request is approved and the termination effective date has not passed, the status is Enrolled. When the termination effective date occurs, the status will be Enrollment Ended. No further actions can be taken on this enrollment.
When rejected, the child remains enrolled in the class.

VPK Bulk Enrollment Process
In addition to the enrollment method described in “Enrolling a VPK Child,” providers may submit enrollment requests to the coalition via a file process. To begin, click the Bulk VPK Enrollment tab. The bulk file processing page displays.

Next, click on the link to download the CSV file template. The file may appear at the bottom of the computer screen depending on the user's browser.

Open the file and expand the columns. Each column is explained below.
A. **Provider ID** = this is the provider ID for the site displayed on the Provider Portal home page/dashboard.

B. **Certification Number** = this is the child’s certificate number listed on their COE. The field is not case sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e. VPK####-YYYY).

C. **Child First Name** = this is the child’s first name listed on their COE. The field is not case sensitive.

D. **Child Last Name** = this is the child’s last name listed on their COE. Do not include a suffix (if any). The field is not case sensitive.

E. **Child DOB (MM/DD/YYYY)** = this is the child’s date of birth listed on their COE. The field will accept M/D/YYYY as well.

F. **VPK Program Year** = this is the child’s approved VPK program year listed on their COE. The field is looking for the first 4-digit year only. For example, if the VPK program year is 2017-2018, the entry would be
2017. Generally, the 4-digit VPK program year matches the year included at the end of the child’s COE number.

G. **Class ID** = this is the desired class’s 4-digit ID. The class ID must be entered as the 4-digit assigned ID. Do not include the class name (if any). Looking at the example below, the entry would be “AS17” not “Songbirds” or “AS17-Songbirds.”

![Class ID Example](image)

H. **Anticipated Start Date (MM/DD/YYYY)** = this is the date the child will begin attending class. Typically, this is the class start date unless the child is starting after the class begins. **NOTE:** An anticipated start date cannot be before the class start date or after the class end date. And, an anticipated start date cannot be before the child’s COE issue date. The field will accept M/D/YYYY as well.

I. **MSID (XX-XXXX)** = this field is for public schools only. Public schools may enter their Master School Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed by a hyphen and 4-digit school number. The MSID number can be used in lieu of the Provider ID in column A. Both IDs are accepted.

When the file is complete, name it and save it as a CSV file type.

**NOTE:** It may be helpful to include your provider name and class in the file name if troubleshooting is ever necessary.

![Save As](image)
When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format. If this message appears, click Yes.

Click the Upload button. A window displays. Select your file and click Open.

The file upload will begin. The file details will populate on a row and turn green. Click the Refresh button to populate the results.

The file details will be updated. The file size, total records count, committed records count, failed records count, processed time, status, and final results are updated. The file results are also returned and can be downloaded by clicking on the Download button.
In this example, there is one failed record and three committed records. The file download will include the error message and status for each record submitted. The three committed records are now “Enrollment Submitted” and the failed record was not included because of an invalid date of birth. The same validations that occur with a manual child enrollment occur with the bulk enrollment file process.

The three committed records are displayed on the class’s enrollment roster as “Enrollment Submitted” and the coalition receives the enrollment requests for review/approval/rejection. In addition, the family receives a notification that their child’s enrollment is in progress. The same processes that occur with a manual child enrollment occur with the bulk enrollment file process.

**NOTE:** When correcting records and re-uploading the file, be sure to remove the “Error or Status” column as it is not accepted for the upload. Also, it is best to NOT include records that have already been submitted successfully as they will now error as having been processed. When removing successful records and the Error or Status column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the information. Excel often retains formats even if the cells are now empty.
Enrollments - SR
Contact your local early learning coalition for more information.
Temporary Closures

Creating a Temporary Closure

Temporary closures must be created when the whole site or program is temporarily closed due to emergency circumstances. Provider and Coalition users can initiate temporary closures.

**NOTE:** Temporary closures must be created BEFORE attendance is submitted for the month in which the closure occurs.

To add a closure, navigate to **Attendance** → **Temporary Closures**.

Click the **Temporary Closures** Submenu item.

Click the **Add Closure** button.
The Report Temporary Closure pop up message will appear.

Complete the form. Hover over the information icons for additional information.

a. Temporary Closure Type – When an entire site is temporarily closed due to emergency circumstances, where all programs and children are impacted, select “Yes, the whole site was closed. Services were not provided to any children.”

b. Closed Provider Site(s) – Select the site(s) that were completely temporarily closed due to emergency circumstances. Each site that the user has access to is listed.

NOTE: If providers were closed for different dates, they should be unchecked and have separate closure events created.
c. Closure Details – Enter the closure date range. The “From” date is the first day of the closure and the “To” date is the last day of the closure. A single day closure would have the same “From” and “To” date. No services are rendered on dates included in the closure date range.

**NOTE:** The closure date range is limited to a single month. If the closure crosses into the next month, you will need to create an additional closure to cover that time period.

d. Closure Reasons – Select the applicable reasons. If the ‘Other’ option is checked, enter comments.

e. Documentation – Click the **Upload Document** button to upload necessary documents (not mandatory).

f. Comments – Enter comments (Not mandatory).
Click the **Save** button to save the record. The message closes and the record appears in the grid with “Incomplete” status.

To edit a temporary closure record, click the **Edit** button.
Edit the closure details and click **Submit to Coalition**.

After clicking the **Submit to Coalition** button, the **Sign and Certify** message appears. Fill in the **Sign and Certify** fields and click the **Submit** button.
The record changes to Submitted status.

Once the submitted record is processed by the coalition, the record changes to Processed status.

**NOTE:**

1. When the status of the record is *Submitted*, there is only a *View* button. The provider cannot edit or delete a temporary closure record that is in *Submitted* or *Coalition Reviewing* status.
2. Only *Processed* records will have a value in the Payable field.
3. *Incomplete* and *Processed* records can be deleted.
4. When a coalition adds more providers to the closure that the provider user does not have access to, there will not be a *Remove* button.

**Updating VPK Class Calendar**

After the coalition processes a temporary closure, VPK providers have additional steps to complete the process.

On the Provider Portal dashboard select **Contracts > Manage Contracts** or click the VPK Provider Application link under Common Tasks.
Click the **Edit** button for the VPK-APP.

Click the VPK Calendars tab to open the calendar section.
Click the **Edit** button to make changes to the calendar. Click the arrow to scroll to the particular calendar month to make edits/changes.

**NOTE:** The system defaults to the first calendar month of the class.

Select the desired emergency closure day(s) by clicking on the day(s) within the calendar.

**NOTE:** Multiple days may be selected by clicking and dragging days.
After selecting a day, a pop-up will appear. There are two event types available.

**Instructional Day Exception** – use if provider does not plan to make up calendar days for the emergency closure (up to 5 days permitted).

**Non-Instructional Day** – use if provider plans to deduct the calendar hours for the emergency closure days and revise its class calendar to restore days.

**Instructional Day Exception**
For closures that do not reduce hours, select Instructional Day Exception as the event type.
Once the Instructional Day Exception is selected, the provider will enter a description and time range for the particular day(s) they were closed. In the image below, the description example uses the verbiage “Closed due to Hurricane Dorian.” The provider will have to choose the same time range for the days as they listed on their calendars. Any hours chosen outside of their Start and End times will change their total calculated hours. Click **Update**.

**NOTE:** If the provider has different instructional hours per day, a separate exception day event should be created for each day (i.e. Mondays are 3 hours and Tuesdays are 3.5 hours) so that the exact hours of the instructional day are entered for the exception day event.
The information is displayed on the calendar. The total calculated class hours and total instructional days have not changed. Click **Save**.

**NOTE:** These steps must be completed for each impacted calendar. For example, some providers may have a morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were impacted due to the closure, both calendars must be edited.

When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information and click the **Submit VPK Provider Application** button.
Non-Instructional Day
For providers that will deduct the calendar hours for those days and revise its class schedule to restore days, select Non-Instructional Day as the event type.

Once the Non-Instructional Day type is selected, the provider will enter a description for the particular day(s) they were closed. In the image below, the description example uses the verbiage “Closed due to Hurricane Dorian.” Click Update.
The totaled calculated hours will be reduced for each non-instructional day based on the hours defined for the day. Next, make the appropriate change to the calendar to add the make-up days. This can be accomplished in a variety of ways such as canceling previously identified non-instructional days, extending the class end date, or even extending the time on some instructional days (by creating exception days with different hours). When complete, click **Save**.

**NOTE:** These steps must be completed for each impacted calendar. For example, some providers may have a morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were impacted due to the closure, both calendars must be edited.
When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information and click the **Submit VPK Provider Application** button.
Attendance - VPK

Providers manage VPK attendance online by navigating to the Attendance menu item and selecting Manage VPK Attendance. Providers may submit their attendance through the web page or using a bulk file upload, similar to the bulk enrollment file upload. It is important to note that changes to enrollment, such as entering a termination date, or changes to the class schedule, such as reporting a site closure, cannot be performed in attendance. Enrollment information must be corrected in the Enrollments area. Class schedule information must be corrected in the Contracts > VPK Provider Application area. Any changes to source data should be done prior to submitting attendance. Coalitions may assist as needed.

Submitting Attendance Online

Select the Manage VPK Attendance menu item. The VPK Attendance Roster displays, defaulting to the current service period and first class. The blue summary box to the right contains class details such as the class full name, start and end dates, and max class size. If necessary, use the drop downs to select a different service period and/or class.

NOTE: A service period is the month in which services were rendered. Child absences for the service period must be marked, saved, and submitted to the coalition for payment. A due date is displayed for each service period. Providers with multiple classes must submit an attendance roster for each class for payment.

The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing group, or status). The summary feature shows the current/saved attendance information for all children in one view.
To record attendance, click on a child’s name to view their attendance for the month.

- Days the site is closed are marked with an asterisk “*.”
- Days the child is scheduled to attend are marked with an “X” for present.
- A legend is provided in the bottom right for more code descriptions.

To change a present day to absent, click on the “X.” The “X” for present will now appear as an “A” for absent.

**NOTE:** Absences entered by mistake can be changed back to present by clicking on the “A.”

While not required, it is recommended to click **Save** (below the calendar) before moving on to another child. When all child absences are marked for the month, click **Save** and then click the **Submit to Coalition** button. A window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To continue to the **Sign & Certify** page, click **Continue**.
The *Sign and Certify* page displays the class summary with the total number of days absent and days present. At this point, providers may want to print this page using the browser print function. When ready, review the certification statements and complete the Authorized Electronic Signature portion by entering the user’s **Full Name**, checking the box for **Certify by electronic signature**, and clicking **Submit**. To abandon the submission, click **Cancel**.

Submitted Attendance

Upon submission, the screen returns to the VPK Attendance Roster view with the current service period displayed. Select the submitted service period from the drop down. The submitted roster now has a submitted message and each child shows “SUB” for submitted in the status column. This status will change as the child attendance is processed by the coalition.
Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the roster list in red and show “REJ” for rejected in the status column. Only records with “REJ” may be edited.

To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed. After the last record is corrected, click Save. Then, click the Submit to Coalition button and continue to the Sign & Certify page. This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the coalition. Complete the Authorized Electronic Signature portion and click Submit.

Upon submission, the rejected “REJ” records appear on the roster as submitted “SUB.”
Approved Attendance
Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under Attendance> Reimbursement Details.

Uploading Bulk Attendance File
Providers may submit their attendance via a bulk file upload (similar to the enrollment bulk file upload process). To begin, go to the Attendance menu item, choose Manage VPK Attendance, and then select Bulk File Upload.

The Bulk VPK Attendance page displays.

Click the CSV file template link. A window appears. From this window, select the service month and year to generate a file for all of the enrollments (for all classes) at the site that month. Alternatively, multi-site providers may check the "Include all providers for provider principal" box to generate a file for all of the enrollments (for all classes) at all sites associated to the account for that month. Then, click the Download button.
Open the downloaded file. The enrollment information for each class is pre-populated. Each instructional day during the student's enrollment defaults to present (X).

- Legend: present (X), student not started (_), student terminated (T).
- Day_1 = first of attendance month, Day_2 = second day of attendance month, Day_3 = third day of attendance month, etc. In this example, Day_1 = August 1, Day_2 = August 2, and Day_3 = August 3.
- Regardless of the month/year, columns for Day_1 to Day_31 are included in the file and are necessary for the upload; none should be removed.
- It is critical that only the content of "Day_#" columns are changed (i.e. changing an X to an A). Attempting to add students or edit/remove system generated columns will cause errors. The file is a reflection of the enrollment information for the class when downloaded. If issues are identified, please contact the local early learning coalition for assistance.

Scroll over to the days and record absences by changing a present day (X) to absent (A). Tip: (In Excel) Open the View menu, select column H, and click Freeze Panes. This will keep the student's name and demographic information in view while scrolling through days.
(In Excel) When complete, un-hide and/or un-freeze any columns. Click File> Save As. Re-name file and save locally. Be sure the file type is .csv.

On the Provider Portal, click the **Upload** button. A file manager window opens. Locate the saved file and click **Open**.

The uploaded file displays in the Bulk VPK Attendance log.

Click the **Refresh** button to get final results.

The successfully submitted attendance is now reflected on the class attendance roster. Each record shows "SUB" for submitted.
**Attendance - SR**

Providers manage SR attendance online by navigating to the Attendance menu item and selecting **Manage SR Attendance**. Providers may submit their attendance through the web page. It is important to note that changes to enrollment, such as entering a termination date, cannot be performed in the attendance module but rather the Manage SR Enrollment area. Also, when issues appear on the attendance roster (such as incorrect enrollment information, missing children, duplicate children, missing paid holidays, duplicate absences on the same day, etc.), the issues should be communicated to the coalition before submitting the attendance roster. Coalitions may assist in addressing the issues so that the attendance records have accurate information.

### Submitting Attendance Online

Select the **Manage SR Attendance** menu item. The SR Attendance Roster displays, defaulting to the current service period. The blue summary box to the right contains provider details and paid holiday information for the service period.

![Attendance Roster Screenshot](image)

**NOTE:** A service period is the month in which services were rendered. Child absences for the service period must be marked, saved, and submitted to the coalition. A due date is displayed for each service period. Providers that contract with multiple coalitions must submit an attendance roster to each coalition.

Children that are “Enrolled” or “Pending Parent Acceptance” are included on the SR attendance roster. Children that are “Pending Parent Acceptance” are listed first and have an initial status of “PND”; children that are “Enrolled” do not have an initial status. When “PND” children are listed, a provider message will also appear. Clicking **OK** dismisses the message.
The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing group, or status). The summary feature shows the current/saved attendance information for all children in one view.

To record attendance, click on a child’s name to view their attendance for the month.

- Days the site is closed are marked with an asterisk “*”
- Days the child is not scheduled to attend are marked with “NS”. If the entire month for a child is marked “NS”, contact the local early learning coalition to correct the care days.
- Days the child is scheduled to attend are marked with an “X” for present along with his/her scheduled unit of care
- Paid holidays where a child is also scheduled to attend are marked with an “H”
- A legend is provided in the bottom right for more code descriptions

**NOTE:** The “Child’s Current Information” displayed on the right is current as of today. When working prior months, the information displayed may not align. For example, if a child’s enrollment was terminated in February 2019, the current enrollment status is *Enrollment Ended*. Each month (prior to February) will also display *Enrollment Ended* in the “Child’s Current Information” area because it is the current enrollment status. This does not impact the ability to record attendance for those prior months. Enhancements are planned to address the display.

To change a present day to absent, click on the “X.” A pop-up message appears to collect more information.

a. Select an absent reason from the dropdown.
b. Include a message to the coalition regarding the absence in the Note area. *(optional for most reasons)*
c. Attach a file for supporting documentation by clicking Choose File. *(optional)*
d. Click Save when done and the pop-up message will close.
e. The “X” for present will now appear as an “A” for absent.
f. **NOTE:** Consecutive absences must be entered per day (i.e. there isn’t a click and drag feature to select multiple days at once). However, it is not necessary to upload the same document per day when it applies to multiple days. Upload the document on one of the absences and reference it in the Note area for the other absences.
g. Absences entered by mistake can be changed back to present by clicking on the “A.” A message will appear to confirm the change. Clicking Yes removes the saved absence information, deletes the document, and changes the “A” for absent to “X” for present.

While not required, it is recommended to click Save (below the calendar) before moving on to another child. When all child absences are marked for the month, click Save and then click the Submit to Coalition button. A window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To continue to the Sign & Certify page, click Continue.
The *Sign and Certify* page summarizes the information for each child and an electronic signature is required.

Submitted Attendance

Upon submission, the screen returns to the SR Attendance Roster view with the current service period displayed. Select the submitted service period from the drop down. The submitted roster now has a submitted message and each child shows “SUB” for submitted in the status column. This status will change as the child attendance is processed by the coalition.
Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the roster list in red and show "REJ" for rejected in the status column. Only records with "REJ" may be edited.

To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed. After the last record is corrected, click **Save**. Then, click the **Submit to Coalition** button and continue to the **Sign & Certify** page. This time, the **Sign & Certify** page only shows the rejected records that are being re-submitted to the coalition. Complete the Authorized Electronic Signature portion and click **Submit**.

Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."
Approved Attendance
Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under Attendance> Reimbursement Details.